Internet Support
Email: measure.support@natinst.com
National Instruments Home Page: http://www.natinst.com
FTP Site: ftp.natinst.com

Bulletin Board Support
BBS United States: (512) 794-5422 or (800) 327-3077
BBS United Kingdom: 01635 551422
BBS France: 1 48 65 15 59

FaxBack Support
(512) 418-1111

Telephone Support (U.S.)
Tel: (512) 795-8248
Fax: (512) 794-5678

International Offices
Australia 03 9 879 9422, Austria 0662 45 79 90 0, Belgium 02 757 00 20,
Canada (Ontario) 519 622 9310, Canada (Quebec) 514 694 8521, Denmark 45 76 26 00,
Finland 90 527 2321, France 1 48 14 24 24, Germany 089 741 31 30,
Hong Kong 2645 3186, Italy 02 413091, Japan 03 5472 2970, Korea 02 596 7456,
Mexico 95 800 010 0793, Netherlands 0348 433466, Norway 32 84 84 00,
Singapore 2265886, Spain 91 640 0085, Sweden 08 730 49 70,
Switzerland 056 200 51 51, Taiwan 02 377 1200, U.K. 01635 523545

National Instruments Corporate Headquarters
6504 Bridge Point Parkway Austin, TX 78730-5039  Tel: (512) 794-0100
Important Information

Warranty

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THEREFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National Instruments Corporation.

Trademarks

Measure® is a trademark of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the user or application designer. Any use or application of National Instruments products for or involving medical or clinical treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards, equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always continue to be used when National Instruments products are being used. National Instruments products are NOT intended to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health and safety in medical or clinical treatment.
About This Manual

Organization of This Manual.............................................................................................................. ix
Conventions Used in This Manual .................................................................................................... x
Customer Communication................................................................................................................. xi

Chapter 1

Introduction..................................................................................................................................... 1-1
Installing Measure ......................................................................................................................... 1-1
Manually Adding or Removing the GPIB Add-In ................................................................. 1-1
Uninstalling Measure ..................................................................................................................... 1-2

Chapter 2

Getting Started with GPIB Tasks ............................................................................................... 2-1
Instruments ....................................................................................................................................... 2-1
Example—Configure the Fluke 45 Multimeter ................................................................. 2-2
Example—Test the Instrument Connection ................................................................................ 2-3
Tasks.............................................................................................................................................. 2-4
Capture Tasks................................................................................................................................. 2-4
Fields............................................................................................................................................. 2-6
 Parsing by Custom–defined Delimiters ...................................................................................... 2-6
 Parsing by Width ............................................................................................................................ 2-6
 Parsing by the Default Delimiter ................................................................................................. 2-7
Transmission Tasks ......................................................................................................................... 2-7
Example—Create an Instrument Configure Task ............................................................ 2-8
Example—Create an Instrument Read Task ............................................................................. 2-9
Example—Run Your GPIB Tasks .............................................................................................. 2-10
Example—Add Tasks to the GPIB Menu ................................................................................... 2-12
Communication Strings.................................................................................................................. 2-12
Chapter 3
GPIB Task Reference .................................................................3-1
  GPIB Instrument Setup Dialog Box ........................................3-1
  Instrument Test Dialog Box ..................................................3-3
  Advanced Instrument Setup Dialog Box ...............................3-4
  Tasks Dialog Box ..................................................................3-6
  Capture Task Dialog Box ......................................................3-7
  Transmission Task Dialog Box ..............................................3-10
  Define Fields Dialog Box .....................................................3-12

Chapter 4
Using Measure GPIB Tasks with VBA .......................................4-1
  Calling Functions from VBA ..................................................4-1
  GPIB Add-In Functions .......................................................4-2

Appendix A
Error Codes and Solutions

Appendix B
Customer Communication

Glossary

Index

Figures
  Figure 1-1. GPIB Add-Ins Dialog Box .....................................1-2
  Figure 2-1. GPIB Instrument Setup Dialog Box .....................2-3
  Figure 2-2. GPIB Instrument Test Dialog Box .......................2-4
  Figure 2-3. Capture Task: Switching the Fluke 45 to Volts DC ....2-9
  Figure 2-4. Capture Task: Reading Data from the Fluke 45 ......2-10
  Figure 2-5. VBA Code to Read Data From the Fluke 45 .........2-11
  Figure 3-1. GPIB Instrument Setup Dialog Box .....................3-1
  Figure 3-2. Instrument Test Dialog Box ..................................3-3
  Figure 3-3. Advanced Instrument Setup Dialog Box ..............3-5
  Figure 3-4. GPIB Tasks Dialog Box .......................................3-6
  Figure 3-5. Capture Task Dialog Box .....................................3-8
  Figure 3-6. Transmission Task Dialog Box ...........................3-10
Figure 3-7. Define Fields Dialog Box ................................................................. 3-12

Tables
Table 2-1. GBIB Commands .................................................................................. 2-13
Table 3-1. GPIB Instrument Setup Options ......................................................... 3-2
Table 3-2. Instrument Test Options ...................................................................... 3-4
Table 3-3. Advanced Instrument Setup Options .................................................. 3-5
Table 3-4. GPIB Tasks Dialog Box Options ......................................................... 3-7
Table 3-5. Capture Task Dialog Box Options ..................................................... 3-8
Table 3-6. Transmission Task Dialog Box Options ............................................. 3-11
Table 3-7. Define Fields Dialog Box Options ..................................................... 3-13
Table A-1. Measure Return Values ...................................................................... A-1
Table A-2. GetGPIBError Error Codes ................................................................. A-1
The *Measure GPIB User Manual* describes how to install, set up, and use the Measure GPIB Add-In for Microsoft Excel. You should be familiar with the operation of Microsoft Excel, your computer, and your computer’s memory system.

## Organization of This Manual

The *Measure GPIB User Manual* is organized as follows.

- Chapter 1, *Introduction*, describes the procedures for installing and uninstalling Measure for Windows, and for adding and removing the GPIB Add-in.

- Chapter 2, *Getting Started with GPIB Tasks*, explains how to get started with GPIB tasks. It describes instruments, tasks, and how the GPIB Add-in of Measure for Windows allows you to communicate from MS Excel to instruments connected to a GPIB card in your computer.

- Chapter 3, *GPIB Task Reference*, describes and outlines procedures for using every menu and dialog box available in the GPIB Add-In.

- Chapter 4, *Using Measure GPIB Tasks with VBA*, describes the functions that the GPIB Add-In adds to Visual Basic for Applications (VBA), the programming language built into Microsoft Excel.

- Appendix A, *Error Messages*, describes the errors that can be encountered while using the GPIB Add-In, some conditions under which they might occur, and possible solutions.
• Appendix B, Customer Communication, contains forms you can use to request help from National Instruments or to comment on our products and manuals.

• The Glossary contains an alphabetical list and description of terms used in this manual, including abbreviations, acronyms, metric prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in this manual, including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual.

**bold**

Bold text denotes a parameter, or the introduction of menus, menu items, or dialog box buttons or options.

*italic*

Italic text denotes emphasis, a cross reference, or an introduction to a key concept.

**bold italic**

Bold italic text denotes a note, caution, or warning.

*monospace*

Text in this font denotes text or characters that are to be literally input from the keyboard, sections of code, programming examples, and syntax examples. This font is also used for the proper names of disk drives, paths, directories, programs, subprograms, subroutines, device names, functions, variables, filenames, and extensions, and for statements and comments taken from program code.

»

The » symbol leads you through nested menu items, and dialog box options to a final action. The sequence

Files»Page Setup»Options»Substitute Fonts

directs you to pull down the File menu, select the Page Setup item, select Options, and finally select the Substitute Fonts option from the last dialog box.

⚠️ **Note:** This icon to the left of bold italicized text denotes a note, which alerts you to important information
Customer Communication

National Instruments wants to receive your comments on our products and manuals. We are interested in the applications you develop with our products, and we want to help you if you have problems with them. To make it easy for you to contact us, this manual contains comment and technical support forms for you to complete. These forms are in Appendix B, *Customer Communication*, at the end of this manual.
Introduction

This chapter describes the procedures for installing and uninstalling Measure for Windows, and for adding and removing the GPIB Add-In.

Installing Measure

If you have already installed Measure for Windows and want to add the GPIB Add-In, skip below to the section *Manually Adding or Removing the GPIB Add-In*.

Otherwise, to install Measure for Windows, insert the installation disk and run `a:\setup.exe` from the taskbar in Windows 95 or from the Program Manager for other versions of Microsoft Windows. Use the setup program to install the Data Acquisition Add-In, the Serial Add-In, the GPIB Add-In, or any combination of the three add-ins.

The setup program stores all the necessary files in a directory you specify and installs Measure as an Excel add-in.

Manually Adding or Removing the GPIB Add-In

To add the GPIB Add-In manually, complete the following steps.

1. Start Excel and select `Tools»Add-Ins...`, which brings up the GPIB Add-Ins dialog box, shown in Figure 1-1.
2. Click on the `Browse` button, and select the path where the setup program installed Measure. The default directory is `measure`.
3. Enter `GPIB.xla` in the File Name edit box, and press Enter. The item `Measure GPIB Add-In` appears in the list box.
4. Click on `OK` to close the Add-Ins dialog box.
You also can remove the GPIB Add-In manually. To do so, complete the following steps.

1. From the GPIB Add-Ins dialog box, shown in Figure 1-1, click on the checkbox next to the item Measure GPIB Add-In.
2. When you have removed the check mark, click on OK to close the dialog box.

![Add-Ins Dialog Box](image)

**Uninstalling Measure**

To uninstall Measure, remove the Serial Add-In, the Data Acquisition Add-In, and the GPIB Add-In from the Add-ins list in Excel. Double-click the Uninstall icon in the Measure folder to remove Measure from your computer.
Getting Started with GPIB Tasks

This chapter explains how to get started with GPIB tasks. It describes instruments, tasks, and how the GPIB Add-In of Measure for Windows allows you to communicate from MS Excel to instruments connected to a GPIB card in your computer. Measure sends commands to your instruments, reads data from your instruments, and stores it in a spreadsheet, or takes data from a spreadsheet and sends it to your instruments.

Objects in Measure, called tasks, are the method of communication. You can define one or more tasks for each instrument. Once you have created a task, you can run it from the GPIB Tasks dialog box, from the GPIB menu, or from any Visual Basic for Applications (VBA) code, the programming language built into Microsoft Excel.

Throughout this chapter, examples and step by step instructions are given to help you get started with GPIB tasks.

Measure adds four VBA functions, allowing more sophisticated communication between the computer and the GPIB device. For more information about these functions, see Chapter 4, Using Measure GPIB Tasks with VBA.

Instruments

In Measure, an instrument is a name given to the information about a physical device, such as the GPIB address and communications settings. You must configure an instrument before Measure can use it. After you configure an instrument, you can create tasks to interact with the instrument.

The sections below present two examples of setting up and collecting data from an instrument.
Example—Configure the Fluke 45 Multimeter

This example outlines the steps for setting up and collecting data from a Fluke 45 Multimeter using GPIB. Both menu-driven and VBA operations are illustrated. The workbook containing this example is distributed with Measure as the file gpbflk45.xls.

The Fluke 45 Multimeter is capable of measuring AC & DC voltage, AC & DC current, and frequency, among other things. The goal of this example is to switch the multimeter to Volts DC mode and read the voltage 10 times at one second intervals. The following two Fluke 45 commands are used in this example.

1. Computer transmits vdc.
   The multimeter switches to Volts DC mode.

2. Computer transmits val1?
   The multimeter returns its value at that instance as a string of the form 9.99999E9\10. The combination \10 represents the linefeed character (ASCII 10) returned from the instrument.

Before you can create the tasks you need, you must configure the instrument.

1. Select GPIB » Instruments to show the GPIB Instrument Setup dialog box, shown in Figure 2-1.
2. Click on the New button and type the name of the instrument, Fluke 45.
3. Select the Board Index, Primary Address, and Secondary Address where the Fluke 45 is located.

Now you have set up the Fluke 45 for communication with Measure.
Example—Test the Instrument Connection

After setting up the instrument, you can test that the instrument is connected and set up properly from the Instrument Setup dialog box.

1. Press the Test button to display the Instrument Test dialog box, shown in Figure 2-2. From this dialog box, you can send commands to the instrument and view its response.

2. In the Transmit field, type val1? and press Enter.

3. The Fluke 45 Multimeter should respond with the current voltage reading. If no response appears from the instrument, try clicking on the Read Data button to read the port again. Of course, if you are just following these steps as a tutorial and do not actually have a Fluke 45 Multimeter, there will not be any response.

4. Close the Instrument Test dialog box, by clicking on the OK button.
Chapter 2  Getting Started with GPIB Tasks

Figure 2-2. GPIB Instrument Test Dialog Box

Tasks

Operations done on instruments are called tasks. There are two types of tasks: capture tasks and transmission tasks. Before you create a task, you must configure an instrument. To create a task, complete the following steps.

1. Select GPIB » Tasks to open the Tasks dialog box.
2. Select the correct instrument from the Instrument drop-down box, and click on the New Capture or New Transmit button to create a new task. The Edit Capture Task dialog box or the Edit Transmit Task dialog box appears.

Capture Tasks

A capture task is a repeating process that reads data from an instrument, parses the data into fields, and stores the data in a spreadsheet range. When a capture task begins, the following steps occur.
1. If the **Clear Instrument** checkbox is checked, Measure clears the instrument.

2. If an initialization command is given, Measure sends it to the instrument.

A capture task is complete when each of the following steps occurs once for each row in the spreadsheet range.

3. If the corresponding checkbox is checked, Measure triggers the instrument.

4. If the corresponding checkbox is checked, Measure waits for the instrument to assert SRQ to request service before continuing.

5. If a command string is given, Measure sends it to the instrument.

6. Measure reads data from the instrument. If fields are defined, the data is parsed into fields. If an end-of-line string is defined, Measure continues to step 7 when the end-of-line string is encountered. If no end-of-line string is defined, Measure continues to step 7 when all the defined fields are read. Notice that delimiting characters take precedence over end-of-line strings. If no end-of-line string is defined and no fields are defined, but you have specified a range to store the results, Measure waits for a Carriage Return (\13), Line Feed (\10), or the EOI signal from the device (\EOI). When any of these standard termination characters are encountered, Measure puts all data before the termination characters in the specified worksheet cell, and throws away the termination characters.

7. The received data is stored in the current row of the given range. If fields are defined, the data is stored in columns that correspond to the fields. If no fields are defined, all received data is put in the first column of the current row. If no range is given, any data received is thrown away.

8. If a response string is given, Measure sends it to the instrument.

9. If a delay is given, Measure waits the given number of milliseconds before continuing.

10. The sequence starts again at step 3, using the next row in the range to store the captured data. The task finishes when all rows in the range are used or no range is given.

If no range is given, Measure executes the sequence one time, and ignores any data received from the instrument. This is a convenient way to send simple commands to the instrument.
Fields

When an instrument reads data using a capture task, it is useful to parse the data and separate it into fields. A capture task allows you to parse captured data using delimiters (such as a comma, or semicolon) or by defining the width of each field. If no fields are defined, Measure places all data received before the end-of-line string into one cell.

In the following three examples, one parses by custom-defined delimiters, another by width, and the third by the default delimiter.

Parsing by Custom-defined Delimiters

Assume you have an instrument that returns a measurement of two coordinates, x and y. The instrument returns a string of the form $x, y\backslash13\backslash10$, where $x$ and $y$ each can be from 1 to 5 digits. In this case, the best parsing method is to use delimiters. The simplest solution is to create two fields. The first field has a comma as a delimiter, and the second field has $\backslash13\backslash10$ as its delimiter. In this case, no end-of-line characters are used because the fields you defined completely define the data sent by the instrument.

Parsing by Width

When an Ohaus scale is asked for its current weight, it responds with a 20 character string of the following format:

<table>
<thead>
<tr>
<th>Field</th>
<th>Polarity</th>
<th>Weight</th>
<th>Blank</th>
<th>Mode</th>
<th>Stability</th>
<th>Address</th>
<th>Cr/Lf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>1</td>
<td>8</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

Picking out the weight field from this string is accomplished easily by parsing by width because you know the location and width of the data you want. There are several variations on the solution, but the simplest solution is to create two fields, field one being one character wide and field two being eight characters wide. Additionally, the end-of-line character must be set to $\backslash13\backslash10$ to indicate the end of a string. All characters between the weight field and $\backslash13\backslash10$ are thrown away because no fields were defined for them. Another solution is to define three fields, field one being one character wide, field two being eight characters wide, and field three being eleven characters wide. In this case, no end-of-line characters are necessary, because the string returned from the scale is 20 characters wide.
Parsing by the Default Delimiter

Using the default delimiter you can parse data into more fields than were defined originally. The default delimiter is especially useful when an instrument sends multiple fields delimited by the same delimiter. For example, data of the form x1, x2, x3, x4, x5, x6, x7, x8, x9, x10 could be parsed in two ways. First, you could create 10 fields, all delimited by commas. A simpler solution would be to create no fields at all, but set the default delimiter to a comma.

It is important to understand how Measure parses the data using each of the two solutions. When you create 10 fields, Measure reads 10 fields from the instrument, no matter how many columns in the range you provide to store the result. However, if an end of line character is encountered before all 10 fields are read, Measure stops reading the current row and continues with the next row. If you use a default delimiter, Measure continues to read fields for the current row until an end of line character is encountered, or data for every column in the range has been read.

Transmission Tasks

A transmission task reads data from a spreadsheet range and sends the data to an instrument. A transmission task is a repeating process that reads data from a spreadsheet and sends it to an instrument. When a transmission task begins, the following steps occur.

1. If the Clear Instrument checkbox is checked, Measure clears the instrument.
2. If an initialization command is given, Measure sends it to the instrument.
3. If the corresponding checkbox is checked, Measure triggers the instrument.
4. If the corresponding checkbox is checked, Measure waits for the instrument to assert SRQ to request service before continuing.
5. If a command string is given, Measure sends it to the instrument.
6. The data from the first column of the current row of the range is sent to the instrument. If no range is given, this step is skipped.
7. If an end-of-line string is given, Measure sends the end-of-line string to the instrument.
8. If a response string is given, Measure waits for the instrument to send the response string.
9. If a delay is given, Measure waits the given number of milliseconds before continuing.
10. The sequence starts again with step 3, using the next row in the range. The sequence completes when all rows in the range are used or no range is given.
11. If a repeat count is given, steps 3-10 are repeated the given number of times.

If no range is given, Measure executes the sequence one time, and ignores any data received from the instrument. This is a convenient way to send simple commands to the instrument.

Example—Create an Instrument Configure Task

Now that you have configured and tested the instrument, you can create the necessary tasks. In this example, create a task to switch the multimeter to Volts DC mode. Because this task is a simple command to the instrument, you can create either a capture task or a transmission task. In this case, complete the following steps to create a capture task.

1. Select **GPIB » Tasks**.
2. Select **Fluke 45** from the **Instrument** drop-down list.
3. Click on the **New: Capture** button, and the Capture Task dialog box appears, shown in Figure 2-3.
4. Type **Switch to Volts DC** in the **Task Name** field.
5. Type **vdc** in the **Transmit this command** string field.
6. Click on the **OK** button to close this dialog box.
Example—Create an Instrument Read Task

Now, complete the following steps to create a task to capture the data.

1. Click on the New Capture button, and the Capture Task dialog box appears, shown in Figure 2-4.
2. Type Read in the Task Name field.
3. Type val1? in the Transmit this command string field.
4. Type a1:a10 in the Store the result in this range field.
5. Type \10 in the Wait for this end-of-line string field.
6. Type 1000 in the Delay before restarting sequence field.
7. Click on the OK button to close this dialog box.
Example—Run Your GPIB Tasks

Two tasks are defined now, Switch to Volts DC and Read.

To run the tasks from the Tasks dialog box, complete the following steps.

1. Highlight **Switch to Volts DC** and click on **Run** to run the task that tells the multimeter to measure volts DC.
2. Highlight **Read** and click on **Run** to run the task that reads 10 values from the multimeter.
3. When the Read task is finished, Measure copies the data received into the range a1:a10.
4. Click on **OK** to close the dialog box.
To run the tasks using VBA, complete the following steps.
1. Close the Tasks dialog box by clicking on OK.
2. Select Macro from the Insert menu in Excel.
3. Select Module from the popup menu that appears.
4. Type the following code in the module.
   ```vba
   Sub Sample()
       Dim result As Integer
       result = Application.Run("GPIB", "Switch to Volts DC")
       result = Application.Run("GPIB", "Read")
   End Sub
   
   Your computer screen should appear as shown in Figure 2-5.
   ```
5. Select Tools » Macro.
6. Select Sample from the list box.
7. Click on Run to execute the subroutine.
8. Click on the tab at the bottom of the screen corresponding to the worksheet you were on when you added the module, as shown in Figure 2-5.

9. The data is in the range a1:a10 on the worksheet.

Example—Add Tasks to the GPIB Menu

You can add tasks that are run often to the GPIB menu. To add a task to the menu, complete the following steps.

1. Select **GPIB»Tasks**.

2. Click on the **Edit Menu** button to display the Edit Menu Tasks dialog box. Use this dialog box to add or remove tasks. When both the Edit Menu Tasks and the Tasks dialog boxes are closed using their **OK** buttons, the tasks are added under the **GPIB** menu.

3. To run a task, select it from the menu. When running tasks from the menu, the current selection on the spreadsheet is used as the range of the task. If there is no selection on the active spreadsheet, the range specified in the dialog box is used.

Communication Strings

When communicating with GPIB instruments, it is often necessary to specify characters that are difficult to print. A good example is the carriage-return character (ASCII 13). For this reason, any time a string is requested in a text box, Measure accepts a special sequence of characters to specify unprintable characters. The sequence consists of a backslash (\) followed by up to three numbers representing the base 10 ASCII numeric value of the character. For instance, the carriage-return character (ASCII 13) is represented by the string \13 or \013.

To specify the common carriage-return line-feed pair, use the string \13\10. To specify the backslash character, use \\ For example, the string \\13 specifies a backslash and a carriage-return, while \\13 specifies a backslash followed by a 1 and a 3.

You can specify several important GPIB commands in a similar manner. Table 2-1, GPIB Commands, provides several GPIB commands, and their descriptions.
### Table 2-1. GPIB Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\TRIG</td>
<td>Specifies that Measure should trigger the instrument when it encounters this string.</td>
</tr>
<tr>
<td>\SRQ</td>
<td>Specifies that Measure should wait until the instrument asserts SRQ requesting service.</td>
</tr>
<tr>
<td>\CLR</td>
<td>Specifies that Measure should send the GPIB clear command to the instrument.</td>
</tr>
<tr>
<td>\LOCAL</td>
<td>Specifies that Measure should put the instrument into local mode.</td>
</tr>
<tr>
<td>\EOI</td>
<td>Specifies that Measure should wait for EOI to be raised by the instrument or Measure should raise EOI on the character before the \EOI when transmitting.</td>
</tr>
</tbody>
</table>
This chapter describes and outlines procedures for using every menu and dialog box available in the GPIB Add-In.

**GPIB Instrument Setup Dialog Box**

Use the GPIB Instrument Setup dialog box to configure the communication parameters of instruments that are used with Measure.

You can reach this dialog box by either selecting **GPIB > Setup Instruments**, or clicking on the **Edit Instruments** button from the Tasks dialog box. Figure 3-1 shows the GPIB Instrument Setup dialog box.

![GPIB Instrument Setup Dialog Box](image)
The Instruments list box contains an entry for each instrument defined in Measure. The controls in the Port Setup group box apply to the instrument currently selected in the list box. Table 3-1, GPIB Instrument Setup Options, provides a description of all the options available from the GPIB Instrument Setup dialog box.

### Table 3-1. GPIB Instrument Setup Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Adds a new instrument. The maximum number of instruments is 50.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected instrument.</td>
</tr>
<tr>
<td>Test</td>
<td>Tests communications with the instrument.</td>
</tr>
<tr>
<td>Find Instruments</td>
<td>Locates all instruments connected to the computer, and adds them to Measure.</td>
</tr>
<tr>
<td>Board Index</td>
<td>The index of the GPIB card in the computer connected to the GPIB bus the instrument is connected to.</td>
</tr>
<tr>
<td>Primary Address</td>
<td>The instrument’s primary address. This address usually is set on the front panel of the instrument.</td>
</tr>
<tr>
<td>Secondary Address</td>
<td>The instrument’s secondary address. Most instruments do not support a secondary address.</td>
</tr>
<tr>
<td>Advanced Setup</td>
<td>Brings up the Advanced Setup dialog box. Use the Advanced Setup dialog box to configure the EOS (end-of-string) character and EOI (end-of-information) settings.</td>
</tr>
</tbody>
</table>
Instrument Test Dialog Box

Use the Instrument Test dialog box to test communications between Measure and the instrument. You can reach this dialog box, shown in Figure 3-2, by clicking the Test button on the Instrument Setup dialog box.

![Figure 3-2: Instrument Test Dialog Box](image)

Data typed in the Transmit edit box is sent to the instrument when you click on the Send Data button, or press the Enter key while the cursor is in the Transmit edit box. If you press the Enter key, Measure sends the text in the Transmit edit box along with a carriage-return/linefeed string (\13\10).

After transmitting the data, Measure waits for about 1 second, then displays any data received from the instrument in the Receive edit box. Occasionally, the instrument takes more than 1 second to respond. In that case, press the Read Data button to query the instrument for data again.
Table 3-2, Instrument Test Options, provides a description of all the options available from the Instrument Test dialog box.

Table 3-2, Instrument Test Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmit edit box</td>
<td>Type the text to send to the instrument in this edit box. If the Enter key is pressed, Measure sends the text in this edit box and a carriage return/linefeed string (\13\10) to the instrument. Measure then waits approximately a second, reads the GPIB bus, and puts the results in the Receive edit box. If the instrument takes longer than a second to respond, you have to click on the <strong>Read Data</strong> button to read the data from the instrument.</td>
</tr>
<tr>
<td>Receive edit box</td>
<td>When data is read from the instrument, Measure places it here. Typing in this edit box has no effect.</td>
</tr>
<tr>
<td>Send Data</td>
<td>Click on this button to send the data in the Transmit edit box. Measure sends the data, waits approximately 1 second, reads the instrument, and puts the results in the Receive edit box.</td>
</tr>
<tr>
<td>Read Data</td>
<td>Click on this button to force Measure to read any data available from the instrument. The data is added to the data in the Receive edit box. Data is only read from the instrument when this button is clicked, or data is transmitted to the instrument either by clicking on the Send Data button or pressing the Enter key in the Transmit edit box.</td>
</tr>
</tbody>
</table>

Note: The **Receive edit box** displays only the first 255 characters received.

**Advanced Instrument Setup Dialog Box**

Use the Advanced Instrument Setup dialog box to configure advanced communications parameters for an instrument.

You can reach this dialog box, shown in Figure 3-3, by clicking on the **Advanced Setup** button from the GPIB Instrument Setup dialog box.
The options available from the Advanced Instrument Setup dialog box are shown in Table 3-3.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End-Of-String Character</td>
<td>Used to help Measure know when to assert the EOI line when transmitting data to the instrument.</td>
</tr>
<tr>
<td>Assert EOI when Measure sends EOS</td>
<td>Specifies whether Measure asserts the GPIB EOI line when Measure sends the EOS character.</td>
</tr>
<tr>
<td>Assert EOI at the end of each command</td>
<td>Specifies whether Measure asserts the GPIB EOI line each time Measure sends a command. For example, in a capture task, Measure would assert EOI after sending the string specified in the “Transmit this command string field” and after sending the string specified in the “Transmit this response string.”</td>
</tr>
<tr>
<td>Compare 7-bits of EOS rather than 8</td>
<td>Specifies how many bits of EOS Measure compares in determining when an EOS character is being transmitted or received.</td>
</tr>
<tr>
<td>GPIB Driver Timeout</td>
<td>Specifies the timeout used when Measure makes calls to the GPIB driver.</td>
</tr>
</tbody>
</table>
Tasks Dialog Box

Use the Tasks dialog box, shown in Figure 3-4, to manage tasks associated with instruments. From this dialog box, tasks are created, run, edited, or deleted. Also, the GPIB Instrument Setup dialog box is brought up to edit instruments, and the Menu Tasks dialog box is brought up to edit the menu.

![GPIB Tasks Dialog Box](image)

**Figure 3-4. GPIB Tasks Dialog Box**

The options available from the GPIB Tasks dialog box are shown in Table 3-4.
### Table 3-4. GPIB Tasks Dialog Box Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument list box</td>
<td>Contains all the instruments defined in Measure.</td>
</tr>
<tr>
<td>Tasks list box</td>
<td>Contains all the tasks defined for the currently selected instrument.</td>
</tr>
<tr>
<td>Edit Instruments</td>
<td>Edits the instruments defined in Measure.</td>
</tr>
<tr>
<td>Close Instrument</td>
<td>Closes the instrument selected in the instrument list box</td>
</tr>
<tr>
<td>Create a Task: Capture</td>
<td>Creates a new capture task for the currently selected instrument. There are a maximum of 200 tasks per instrument.</td>
</tr>
<tr>
<td>Create a Task: Transmit</td>
<td>Creates a new transmit task for the currently selected instrument. There are a maximum of 200 tasks per instrument.</td>
</tr>
<tr>
<td>Run</td>
<td>Runs the currently selected task.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the currently selected task.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected task.</td>
</tr>
<tr>
<td>Description</td>
<td>Contains the description of the currently selected task.</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>Edits the list of tasks that appear on the GPIB menu.</td>
</tr>
</tbody>
</table>

**Capture Task Dialog Box**

Use the Capture Task dialog box to edit capture tasks. To reach this dialog box, click on **New Capture** from the Tasks dialog box, or select a capture task on the Tasks dialog box and click on the **Edit** button.
The options available from the Capture Task dialog box are shown in Table 3-5.

**Table 3-5. Capture Task Dialog Box Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Name</td>
<td>The task name must be entered, and no two tasks can have the same name.</td>
</tr>
<tr>
<td>Description</td>
<td>The description appears in the Description field of the Tasks dialog box, and if this task is added to the menu, the description appears on the status bar when this task is selected. This field can be left blank.</td>
</tr>
<tr>
<td>Display status</td>
<td>If checked, Measure displays the Status dialog box while the task is running. Measure always displays the current progress of a running task on the status bar regardless of the state of this checkbox.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear instrument</td>
<td>Specifies that Measure should send a GPIB Clear command to the instrument before running the task.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Determines how long Measure waits for an instrument to send data. Setting the timeout to zero causes Measure to wait indefinitely. When Measure executes a task, clicking on Q interrupts that task.</td>
</tr>
<tr>
<td>Trigger Instrument</td>
<td>Specifies that Measure should trigger the instrument before continuing the task.</td>
</tr>
<tr>
<td>Wait for SRQ</td>
<td>Specifies that Measure should wait for the instrument to assert SRQ to request service before continuing the task.</td>
</tr>
<tr>
<td>Command string</td>
<td>The command string is sent to the instrument. This field can be left blank. Refer to the section on communications strings for help creating this string.</td>
</tr>
<tr>
<td>Result range</td>
<td>The data read from the instrument is parsed into fields and stored in a row of this range. Measure executes the task sequence once for each row in this range. If this field is left blank, Measure executes this sequence once, ignoring any data that is read from the instrument. Leaving the range blank is useful for sending commands that set the instrument to a certain mode. See the section on Ranges for help on specifying the range.</td>
</tr>
<tr>
<td>End-of-line string</td>
<td>If no end-of-line string is defined and no fields are defined, but you have specified a range to store the results, Measure waits for a Carriage Return (\13), Line Feed (\10), or the EOI signal from the device (\EOI). When any of these standard termination characters are encountered, Measure places all data before the termination characters in the specified worksheet cell, and throws away the termination characters.</td>
</tr>
<tr>
<td>Response string</td>
<td>Measure sends this string to the instrument after the end-of-line string is encountered or after all fields have been read if the end-of-line string was not defined. This field can be left blank.</td>
</tr>
<tr>
<td>Delay</td>
<td>This field determines how long Measure waits before starting the process again with the next row in the range. Time is accurate to approximately 100 ms.</td>
</tr>
<tr>
<td>Define Fields</td>
<td>Click on this button to open the Define Fields dialog box.</td>
</tr>
</tbody>
</table>
Transmission Task Dialog Box

Use the Transmission Task dialog box, shown in Figure 3-6, to edit capture tasks. To reach this dialog box, click on New Transmit from the Tasks dialog box, or select a transmit task on the Tasks dialog and click on the Edit button.

Figure 3-6. Transmission Task Dialog Box

The options available from the Transmission Task dialog box are shown in Table 3-6.
Table 3-6: Transmission Task Dialog Box Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Name</td>
<td>The task name must be entered, and no two tasks can have the same name.</td>
</tr>
<tr>
<td>Description</td>
<td>The description appears in the Description field of the Tasks dialog box, and if this task is added to the menu, the description appears on the status bar when this task is selected. This field can be left blank.</td>
</tr>
<tr>
<td>Display status</td>
<td>If checked, Measure displays the Status dialog box while the task is running. Measure displays the current progress of a running task on the status bar, regardless of the state of this checkbox.</td>
</tr>
<tr>
<td>Clear instrument</td>
<td>Specifies that Measure should send a GPIB Clear command to the instrument before running the task.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Determines how long Measure waits for an instrument to send data. Setting the timeout to zero causes Measure to wait indefinitely. When Measure executes a task, clicking on Q interrupts the task.</td>
</tr>
<tr>
<td>Repeat Count</td>
<td>Determines how many times to run the task. For example, setting the repeat count to 5 causes Measure to execute the task five times. If the repeat count is 0, Measure runs the task indefinitely. When Measure executes a task, clicking on Q interrupts the task.</td>
</tr>
<tr>
<td>Trigger Instrument</td>
<td>Specifies that Measure should trigger the instrument before continuing the task.</td>
</tr>
<tr>
<td>Wait for SRQ</td>
<td>Specifies that Measure should wait for the instrument to assert SRQ to request service before continuing the task.</td>
</tr>
<tr>
<td>Command String</td>
<td>The first string sent to the instrument during each iteration of a task. This field can be left blank. Refer to the section in Chapter 2 on communication strings for help creating this string.</td>
</tr>
<tr>
<td>Transmission Range</td>
<td>Measure executes the task sequence once for each row in this range. If the range is blank, Measure executes the sequence once. Leaving the range blank is useful for sending commands that set the instrument to a certain mode. See the Ranges section for help on specifying the range.</td>
</tr>
<tr>
<td>End-of-line String</td>
<td>The end-of-line string is sent to the instrument after the data from the transmission range is sent. This field can be left blank. Refer to the section on Communication Strings for help creating this string.</td>
</tr>
</tbody>
</table>
Response String | After transmitting the command string, data from the range, and the end-of-line string, Measure waits for the instrument to respond with a response string. The timeout value determines how long Measure waits without signaling an error. If this field is blank, Measure skips this step of the sequence. Refer to the section on communication strings for help creating this string.

Delay | This field determines how long Measure waits before starting the process again with the next row in the range. Time is accurate to approximately 100 ms.

Define Fields Dialog Box

Use the Define Fields dialog box, shown in Figure 3-7, to set up how the GPIB Add-In parses data using a capture task. To reach this dialog box, click on the Define Fields button from the GPIB Capture Task dialog box.

![Define Fields Dialog Box](image)

The options available from the Define Fields dialog box are shown in Table 3-7.
## Table 3-7. Define Fields Dialog Box Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Fields</td>
<td>Determines how many fields the data breaks into.</td>
</tr>
<tr>
<td>List Box</td>
<td>Contains an entry for each field that has been defined.</td>
</tr>
<tr>
<td>Parsing Method: Width</td>
<td>If selected, Measure parses data into fields based on the width given for each field.</td>
</tr>
<tr>
<td>Parsing Method: Delimiters</td>
<td>If selected, Measure parses data into fields based on the delimiter for each field.</td>
</tr>
<tr>
<td>Default Delimiters</td>
<td>Sets the delimiter Measure uses by default.</td>
</tr>
<tr>
<td>Field: Delimiter</td>
<td>Sets the delimiter that Measure uses to determine the end of this field.</td>
</tr>
<tr>
<td>Field: Width</td>
<td>Sets the width of the currently selected field.</td>
</tr>
<tr>
<td>Include</td>
<td>Determines whether Measure should store the currently selected field in the spreadsheet or ignore it once it is read.</td>
</tr>
</tbody>
</table>
This chapter describes the functions that the GPIB Add-In adds to Visual Basic for Applications (VBA), the programming language built into Microsoft Excel.

**Calling Functions from VBA**

There are two ways to execute the VBA functions provided by the GPIB Add-In.

1. **Use the Excel method `Application.Run`**.

   As long as the GPIB Add-In is added as an add-in, the functions are called using the following syntax.

   ```vba
   result = Application.Run("FunctionName", argument1, argument2, argument3, ...)
   ```

   A few examples are listed below.

   ```vba
   result = Application.Run("GPIB", "Read some data", "sheet1!a1:a50")
   ```

   ```vba
   result = Application.Run("GPIB.xla!CloseGPIBInstrument", "MyInstrument")
   Application.Run "GPIB", "Read some data"
   ' Note: ignores return value
   ```

2. **Add a reference to the GPIB Add-In, then call the functions directly.**

   To add a reference, you must have a module open instead of a worksheet. To insert a new module, select **Insert»Macro»Module**.

   To add a reference to the GPIB Add-In, select **Tools»References**. Put a check in the checkbox next to `GPIB.xla`, and click on **OK**.
Now, the functions from the GPIB Add-In are called directly, as in the following examples.

```vba
result = GPIB("Read some data", "sheet1!a1:a50")
result = CloseGPIBInstrument("MyInstrument")
RunGPIBTask "Read some data"
' Note: ignores return value
```

Note: The file `gpib_con.txt` contains the constants returned by the Measure VBA functions.

### GPIB Add-In Functions

The GPIB Add-In defines the following four functions that are called from a VBA module.

- CheckSRQ
- CloseGPIBInstrument
- GetMeasureGPIBError
- GPIB

Each function is listed below with details of its use.

#### CheckSRQ

Checks whether the specified instrument has raised the SRQ line on the GPIB bus to request service.

**Syntax**

```vba
Function CheckSRQ(sInstrumentName as string, bSRQ as Boolean) as Integer
```

**Parameters**

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sInstrumentName</td>
<td>Name of the instrument that asserts SRQ.</td>
</tr>
<tr>
<td>bSRQ</td>
<td>Returned by CheckSRQ. It contains True if the instrument asserted SRQ, False otherwise.</td>
</tr>
</tbody>
</table>
Return Value
For a list of return values, see Table A-1, Measure Return Values, in Appendix A, Error Codes and Solutions.

CloseGPIBInstrument
Closes the specified instrument if it is open.

Syntax
Function CloseGPIBInstrument (sInstrumentName as String) as Integer

Parameters
<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sInstrumentName</td>
<td>Name of the instrument to close.</td>
</tr>
</tbody>
</table>

Return Value
For a list of return values, see Table A-1, Measure Return Values, in Appendix A, Error Codes and Solutions.

GetMeasureGPIBError
This function should be called after a Measure function returns MEASURE_ERROR.

Syntax
Function GetMeasureGPIBError() as Integer

Parameters
This function has no parameters.

Return Value
If there was no error, 0 is returned. Otherwise, Measure returns the GPIB error. For a list of possible return values, see Table A-2, GetMeasureGPIBError Return Values, in Appendix A, Error Codes and Solutions.
GPIB

Executes the named task. If sRange is not given, the default range of the task is used. Otherwise, the given range is used.

Syntax

Function GPIB (sTaskName As String, Optional sRange As Variant, Optional ReferenceStyle As Variant) As Integer

Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sTaskName</td>
<td>Name of the task to run</td>
</tr>
<tr>
<td>sRange</td>
<td>String representing the range to use when running the task. sRange should be of the form sheetname!a1:a50, where sheetname! is optional. If sRange is omitted, Measure uses the range defined for the task in the dialog box.</td>
</tr>
<tr>
<td>ReferenceStyle</td>
<td>Either xlA1 or xlR1C1 specifies the reference style of the range passed in. The default reference style is xlA1.</td>
</tr>
</tbody>
</table>

Return Value

For a list of return values, see Table A-1, Measure Return Values, in Appendix A, Error Codes and Solutions.
## Error Codes and Solutions

This appendix describes the errors that can be encountered while using the GPIB Add-In, some conditions under which they might occur, and possible solutions. The following table lists the possible return values for GPIB.

### Table A-1. Measure Return Values.

<table>
<thead>
<tr>
<th>Return Value</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>MEASURE_OK</td>
<td>The task ran successfully.</td>
</tr>
<tr>
<td>-1000</td>
<td>MEASURE_NOTFOUND</td>
<td>The given task was not found.</td>
</tr>
<tr>
<td>-1001</td>
<td>MEASURE_INVALIDRANGE</td>
<td>The given range is invalid.</td>
</tr>
<tr>
<td>-1002</td>
<td>MEASURE_TIMEDOUT</td>
<td>The task timed out while waiting for data from the instrument.</td>
</tr>
<tr>
<td>-1003</td>
<td>MEASURE_INTERRUPTED</td>
<td>The user interrupted the task.</td>
</tr>
<tr>
<td>-1005</td>
<td>MEASURE_ERROR</td>
<td>An error occurred while communicating with the instrument. Call GetMeasureGPIBError to determine the error.</td>
</tr>
</tbody>
</table>

The following table lists the possible return values for GetMeasureGPIBError.

### Table A-2. GetMeasureGPIBError Return Values

<table>
<thead>
<tr>
<th>Error Mnemonic</th>
<th>Error Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDVR</td>
<td>0</td>
<td>System error</td>
</tr>
<tr>
<td>ECIC</td>
<td>1</td>
<td>Function requires GPIB board to be CIC</td>
</tr>
<tr>
<td>ENOL</td>
<td>2</td>
<td>No Listeners on the GPIB</td>
</tr>
<tr>
<td>Error Code</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>EABO</td>
<td>6</td>
<td>I/O operation aborted (timeout)</td>
</tr>
<tr>
<td>ENEB</td>
<td>7</td>
<td>Nonexistent GPIB board</td>
</tr>
<tr>
<td>EDMA</td>
<td>8</td>
<td>DMA error</td>
</tr>
<tr>
<td>ECAP</td>
<td>11</td>
<td>No capability for operation</td>
</tr>
<tr>
<td>EBUS</td>
<td>14</td>
<td>GPIB bus error</td>
</tr>
</tbody>
</table>

**EDVR (0)**

EDVR is returned when the board specified cannot be accessed. This error occurs when you try to access a board or device that is not installed or configured properly.

**Solutions**

- Use the GPIB Configuration utility to ensure that each board you want to access is configured properly.

**ECIC (1)**

ECIC is returned when the GPIB board specified by board index in the Instrument Setup dialog box is not the system controller.

**Solutions**

- Make sure the GPIB board you specify by board index in the Instrument Setup dialog box is the system controller.
- Use the GPIB Configuration utility to ensure that the board you want to use to access the instrument is configured as system controller.

**ENOL (2)**

ENOL usually occurs when a write operation is attempted with no Listeners addressed. For a device write, ENOL indicates that the GPIB address configured for that device in the software does not match the GPIB address of any device connected to the bus, that the GPIB cable is not connected to the device, or that the device is not powered on.
ENOL can occur in situations where the GPIB board is not the CIC and the Controller asserts ATN before the write call in progress has ended.

**Solutions**

- Make sure that the GPIB address of your device matches the GPIB address of the device to which you want to write data.
- Check your cable connections and make sure at least two-thirds of your devices are powered on.

**EABO (6)**

EABO indicates that an I/O operation has been canceled, usually due to a timeout condition or receiving the Device Clear message from the CIC while performing an I/O operation. Frequently, the I/O is not progressing (the Listener is not continuing to handshake or the Talker has stopped talking), or the byte count in the call which timed out was more than the other device was expecting.

**Solutions**

- Increase the timeout period in the Advanced Settings dialog box.
- Make sure that you have configured your device to send data before you request data.

**ENEB (7)**

ENEB occurs when no GPIB board exists at the board index specified in the Instrument Setup dialog box. This problem happens when the board is not physically plugged into the system, the I/O address specified during configuration does not match the actual board setting, or there is a system conflict with the base I/O address.

**Solutions**

Make sure there is a GPIB board in your computer that is properly configured both in hardware and software using a valid base I/O address.
EDMA (8)
EDMA occurs if a system DMA error is encountered when the NI-488.2M software attempts to transfer data over the GPIB using DMA.

Solutions
- You can correct the EDMA problem in the hardware by using the Device Manager to reconfigure the hardware to not use a DMA resource.

ECAP (11)
ECAP results when your GPIB board lacks the ability to carry out an operation or when a particular capability has been disabled in the software and a call is made that requires the capability.

Solutions
Check the validity of the call, or make sure your GPIB interface board and the driver both have the needed capability.

EBUS (14)
EBUS results when certain GPIB bus errors occur during device functions. All device functions send command bytes to perform addressing and other bus management. Devices are expected to accept these command bytes within the time limit specified by the timeout value. EBUS results if a timeout occurred while sending these command bytes.
Solutions

- Verify that the instrument is operating correctly.
- Check for loose or faulty cabling or several powered-off instruments on the GPIB.
- If the timeout period is too short for the driver to send command bytes, increase the timeout period in the Advanced Settings dialog box.
Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary to help us solve technical problems you might have as well as a form you can use to comment on the product documentation. Filling out a copy of the Technical Support Form before contacting National Instruments helps us help you better and faster.

National Instruments provides comprehensive technical assistance around the world. In the U.S. and Canada, applications engineers are available Monday through Friday from 8:00 a.m. to 6:00 p.m. (central time). In other countries, contact the nearest branch office. You may fax questions to us at any time.

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files and documents to answer most common customer questions. From these sites, you can also download the latest instrument drivers, updates, and example programs. For recorded instructions on how to use the bulletin board and FTP services and for BBS automated information, call (512) 795-6990. You can access these services at:

- United States: (512) 794-5422 or (800) 327-3077
  Up to 14,400 baud, 8 data bits, 1 stop bit, no parity
- United Kingdom: 01635 551422
  Up to 9,600 baud, 8 data bits, 1 stop bit, no parity
- France: 1 48 65 15 59
  Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use your Internet address, such as joesmith@anywhere.com, as your password. The support files and documents are located in the /support directories.
FaxBack Support

FaxBack is a 24-hour information retrieval system containing a library of documents on a wide range of technical information. You can access FaxBack from a touch-tone telephone at the following numbers:

(512) 418-1111

E-Mail Support (currently U.S. only)

You can submit technical support questions to the appropriate applications engineering team through e-mail at the Internet addresses listed below. Remember to include your name, address, and phone number so we can contact you with solutions and suggestions.

measure.support@natinst.com

Fax and Telephone Support

National Instruments has branch offices all over the world. Use the list below to find the technical support number for your country. If there is no National Instruments office in your country, contact the source from which you purchased your software to obtain support.

<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>03 9 879 9422</td>
<td>03 9 879 9179</td>
</tr>
<tr>
<td>Austria</td>
<td>0662 45 79 90 0</td>
<td>0662 45 79 90 19</td>
</tr>
<tr>
<td>Belgium</td>
<td>02 757 00 20</td>
<td>02 757 03 11</td>
</tr>
<tr>
<td>Canada (Ontario)</td>
<td>519 622 9310</td>
<td></td>
</tr>
<tr>
<td>Canada (Quebec)</td>
<td>514 694 8521</td>
<td>514 694 4399</td>
</tr>
<tr>
<td>Denmark</td>
<td>45 76 26 00</td>
<td>45 76 26 02</td>
</tr>
<tr>
<td>Finland</td>
<td>90 527 2321</td>
<td>90 502 2930</td>
</tr>
<tr>
<td>France</td>
<td>1 48 14 24 24</td>
<td>1 48 14 24 14</td>
</tr>
<tr>
<td>Germany</td>
<td>089 741 31 30</td>
<td>089 714 60 35</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>2645 3186</td>
<td>2686 8505</td>
</tr>
<tr>
<td>Italy</td>
<td>02 413091</td>
<td>02 41309215</td>
</tr>
<tr>
<td>Japan</td>
<td>03 5472 2970</td>
<td>03 5472 2977</td>
</tr>
<tr>
<td>Korea</td>
<td>02 596 7456</td>
<td>02 596 7455</td>
</tr>
<tr>
<td>Mexico</td>
<td>95 800 010 0793</td>
<td>5 520 3282</td>
</tr>
<tr>
<td>Netherlands</td>
<td>0348 433466</td>
<td>0348 430673</td>
</tr>
<tr>
<td>Norway</td>
<td>32 84 84 00</td>
<td>32 84 86 00</td>
</tr>
<tr>
<td>Singapore</td>
<td>2265886</td>
<td>2265887</td>
</tr>
<tr>
<td>Spain</td>
<td>91 640 0085</td>
<td>91 640 0533</td>
</tr>
<tr>
<td>Sweden</td>
<td>08 730 49 70</td>
<td>08 730 43 70</td>
</tr>
<tr>
<td>Switzerland</td>
<td>056 20 51 51</td>
<td>056 200 51 55</td>
</tr>
<tr>
<td>Taiwan</td>
<td>02 377 1200</td>
<td>02 737 4644</td>
</tr>
<tr>
<td>U.K.</td>
<td>01635 523545</td>
<td>01635 523154</td>
</tr>
</tbody>
</table>
Technical Support Form

Photocopy this form and update it each time you make changes to your software or hardware, and use the completed copy of this form as a reference for your current configuration. Completing this form accurately before contacting National Instruments for technical support helps our applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, include the configuration forms from their user manuals. Include additional pages if necessary.

Name

Company

Address

Fax ( ) Phone ( )

Computer brand Model Processor

Operating system: Windows 3.1, Windows for Workgroups 3.11, Windows NT 3.1, Windows NT 3.5, Windows 95, other (include version number)

Version of Excel (look at Excel’s About box): 5.0, 5.0c, other

Clock Speed MHz RAM MB Display adapter

Mouse yes no Other adapters installed

Hard disk capacity MB Brand

Instruments used

National Instruments hardware product model Revision

Configuration

National Instruments software product Version

Configuration

The problem is

List any error messages

The following steps will reproduce the problem
Hardware and Software Configuration Form

Record the settings and revisions of your hardware and software on the line to the right of each item. Complete a new copy of this form each time you revise your software or hardware configuration, and use this form as a reference for your current configuration. Completing this form accurately before contacting National Instruments for technical support helps our applications engineers answer your questions more efficiently.

National Instruments Products

GPIB Hardware Revision _________________________________________________________
Interrupt Level of Hardware ____________________________________________________
DMA Channels of Hardware ______________________________________________________
Base I/O Address of Hardware ___________________________________________________
NI-488 Driver Version _________________________________________________________

Other Products

Computer Make and Model _____________________________________________________
Microprocessor _____________________________________________________________
Clock Frequency _____________________________________________________________
Type of Video Board Installed _________________________________________________
Operating System ____________________________________________________________
Operating System Version ____________________________________________________
Operating System Mode _______________________________________________________
Programming Language _______________________________________________________
Programming Language Version ________________________________________________
Other Boards in System _______________________________________________________
Base I/O Address of Other Boards ______________________________________________
DMA Channels of Other Boards ________________________________________________
Interrupt Level of Other Boards ________________________________________________
For each instrument you are using:
Name of instrument ______________________________________________________________
Manufacturer of instrument ________________________________________________________
Parity: None, Even, Odd, Mark, Space
Baud rate ________________________________________________________________
Stop bits ______________________________________________________________
Data bits ______________________________________________________________
Flow control: Hardware, Software, None
Version of Measure: (look at the about box) ________________________________
Documentation Comment Form

National Instruments encourages you to comment on the documentation supplied with our products. This information helps us provide quality products to meet your needs.

Title: Measure® GPIB User Manual
Edition Date: August 1996
Part Number: 321295A-01

Please comment on the completeness, clarity, and organization of the manual.

_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________

Thank you for your help.

Name ____________________________
Title ____________________________
Company __________________________
Address __________________________
Phone (_______) ___________________

Mail to: Technical Publications
National Instruments Corporation
6504 Bridge Point Parkway, MS 53-02
Austin, TX 78730-5039

Fax to: Technical Publications
National Instruments Corporation
(512) 794-5678
<table>
<thead>
<tr>
<th>Prefix</th>
<th>Meaning</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>p-</td>
<td>pico-</td>
<td>$10^{-12}$</td>
</tr>
<tr>
<td>n-</td>
<td>nano-</td>
<td>$10^{-9}$</td>
</tr>
<tr>
<td>µ-</td>
<td>micro-</td>
<td>$10^{-6}$</td>
</tr>
<tr>
<td>m-</td>
<td>milli-</td>
<td>$10^{-3}$</td>
</tr>
<tr>
<td>k-</td>
<td>kilo-</td>
<td>$10^3$</td>
</tr>
<tr>
<td>M-</td>
<td>mega-</td>
<td>$10^6$</td>
</tr>
</tbody>
</table>

A

Add-In  A software package designed to integrate into Microsoft Excel.

B

Bit  A single value of 1 or 0. A byte consists of 8 bits.

Byte  The standard method of representing numbers or characters in computers. Eight binary digits (bits) make up a byte.

C

Capture Task  A task used to retrieve data from an instrument and store it in a range in the Excel worksheet.

Command String  A string sent to an instrument.
E
Escape Sequence A special string used to represent an unprintable character. For example, "\10" is the escape sequence for a linefeed character.

F
Field A field is a division of a line of data. Lines are separated into fields using one of the Serial Add-In parsing techniques.

I
Instrument In Measure, a name given to information about the serial port settings of a real instrument.

L
Line A line is a unit of data demarcated by end-of-line strings. A line of data generally corresponds to a row of a transmit or capture range.

M
MB megabytes of memory

P
Parse Parsing consists of breaking up lines of data into smaller, more manageable units, called fields. In the Serial Add-In, you can parse a line of data based on width or using delimiters.

R
Range A group of rows and columns on a spreadsheet.
Response When capturing data from an instrument, the response is the character that Measure sends to the instrument after every line is received. When transmitting data to an instrument, the response is the character that Measure waits for from the instrument before sending another line of data.
S

Synchronous  A method of data communications in which a prearranged number of bits are transferred per second. Synchronization occurs before and after the transmission of blocks of data, rather than before and after every character. There are no start bits or stop bits, as there are in asynchronous communications. Transmitted bits either represent information or are parity bits. See Asynchronous.

T

Transmission Task  A task used to send data from an Excel worksheet to an instrument.

V

Visual Basic for Applications (VBA)  The programming language built into Microsoft Excel.
A
adding GPIB Add-In manually, 1-1 to 1-2
adding tasks to GPIB menu, 2-12
Advanced Instrument Setup dialog box, 3-4 to 3-5
Assert EOI at the end of each command, 3-5
Assert EOI when Measure sends EOS, 3-5
Compare 7-bits of EOS rather than 8, 3-5
End-Of-String Character, 3-5
GPIB Driver Timeout, 3-5
Advanced Setup option, GPIB Instrument Setup dialog box, 3-2
ASCII values, entering, 2-12
Assert EOI at the end of each command option, 3-5
Assert EOI when Measure sends EOS option, 3-5
B
backslash ( character
entering ASCII values, 2-12
entering GPIB commands (table), 2-13
Board Index option, 3-2
bulletin board support, B-1
C
Capture Task dialog box, 3-7 to 3-9
Clear instrument, 3-9
Command string, 3-9
Define Fields, 3-9
Delay, 3-9
Description, 3-8
Display status, 3-8
End-of-line string, 3-9
illustration, 3-8
Response string, 3-9
Result range, 3-9
Task Name, 3-8
Timeout, 3-9
Trigger Instrument, 3-9
Wait for SRQ, 3-9
capture tasks
creating
instrument configure task, 2-2 to 2-3
instrument read task, 2-9 to 2-10
procedure for, 2-4 to 2-5
fields, 2-6
parsing by custom-defined delimiters, 2-6
parsing by default delimiter, 2-7
parsing by width, 2-6 to 2-7
purpose, 2-4
CheckSRQ function, 4-2 to 4-3
Clear instrument option
Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11
Close Instrument option, 3-7
CloseGPIBInstrument function, 4-3
CLR command (table), 2-13
Command String option
Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11
communication strings, 2-12 to 2-13
Compare 7-bits of EOS rather than 8 option, 3-5
customer communication, x-xi, B-1 to B-2

D
Default Delimiters option, 3-13
Define Fields dialog box, 3-12 to 3-13
  Default Delimiters, 3-13
  Field: Delimiter, 3-13
  Field: Width, 3-13
  illustration, 3-12
  Include, 3-13
  List Box, 3-13
  Number of Fields, 3-13
  Parsing Method: Delimiters, 3-13
  Parsing Method: Width, 3-13
Define Fields option, Capture Task dialog box, 3-9
Delay option
  Capture Task dialog box, 3-9
  Transmission Task dialog box, 3-12
Delete button
  GPIB Instrument Setup dialog box, 3-2
  Tasks dialog box, 3-7
delimiters
  parsing fields by custom-defined delimiters, 2-6
  parsing fields by default delimiter, 2-7
Description field
  Capture Task dialog box, 3-8
  Tasks dialog box, 3-7
  Transmission Task dialog box, 3-11
Display status option
  Capture Task dialog box, 3-8
  Transmission Task dialog box, 3-11
documentation
  conventions used in manual, x
  organization of manual, ix-x

E
EABO error code, A-3
EBUS error code, A-4 to A-5
ECAP error code, A-4
ECIC error code, A-2
Edit button, 3-7
Edit Instruments option, 3-7
Edit Menu button, 3-7
EDMA error code, A-4
EDVR error code, A-2
e-mail support, B-2
End-of-line String option
  Capture Task dialog box, 3-9
  Transmission Task dialog box, 3-11
End-Of-String Character option, 3-5
ENEB error code, A-3
ENOL error code, A-2 to A-3
EOI
  Assert EOI at the end of each command option, 3-5
  Assert EOI when Measure sends EOS option, 3-5
EOI command (table), 2-13
EOS
  Compare 7-bits of EOS rather than 8 option, 3-5
  End-Of-String Character option, 3-5
error codes and solutions
  EABO, A-3
  EBUS, A-4 to A-5
  ECAP, A-4
  ECIC, A-2
  EDMA, A-4
  EDVR, A-2
  ENEB, A-3
  ENOL, A-2 to A-3
  GetMeasureGPIBError error codes (table), A-1 to A-2
  Measure return values (table), A-1

F
fax and telephone support, B-2
FaxBack support, B-2
Field: Delimiter option, 3-13
Field: Width option, 3-13
fields
parsing
by custom-defined delimiters, 2-6
by width, 2-6 to 2-7
using default delimiter, 2-7
purpose and use, 2-6
Find and Add Instruments option, 3-2
Fluke 45 Multimeter example
configuring, 2-2 to 2-3
creating instrument configure task, 2-8
to 2-9
creating instrument read task, 2-9 to 2-10
running defined tasks, 2-10 to 2-12
testing instrument connection, 2-3 to 2-4
FTP support, B-1

G
GetMeasureGPIBError function
description, 4-3
error codes (table), A-1 to A-2
GPIB Add-In
adding GPIB Add-In manually, 1-1 to 1-2
communications strings, 2-12 to 2-13
overview, 2-1
removing GPIB Add-In manually, 1-1
to 1-2
GPIB commands, specifying with backslash
(table), 2-13
GPIB Driver Timeout option, 3-5
GPIB function, 4-4
GPIB Instrument Setup dialog box
Fluke 45 Multimeter example, 2-3
GPIB task reference, 3-1 to 3-2
Advanced Setup, 3-2
Board Index, 3-2
Delete, 3-2
Find and Add Instruments, 3-2
New, 3-2
Primary Address, 3-2
Secondary Address, 3-2
Test, 3-2
illustration, 2-3, 3-1
GPIB menu
adding tasks, 2-12
Instruments, 2-2
Tasks, 2-4
GPIB task reference
Advanced Instrument Setup dialog box,
3-4 to 3-5
Assert EOI at the end of each
command, 3-5
Assert EOI when Measure sends EOS,
3-5
Compare 7-bits of EOS rather than 8,
3-5
End-Of-String Character, 3-5
GPIB Driver Timeout, 3-5
Capture Task dialog box, 3-7 to 3-9
Clear instrument, 3-9
Command string, 3-9
Define Fields, 3-9
Delay, 3-9
Description, 3-8
Display status, 3-8
End-of-line string, 3-9
Response string, 3-9
Result range, 3-9
Task Name, 3-8
Timeout, 3-9
Trigger Instrument, 3-9
Wait for SRQ, 3-9
Define Fields dialog box, 3-12 to 3-13
Default Delimiters, 3-13
Field: Delimiter, 3-13
Field: Width, 3-13
Include, 3-13
List Box, 3-13
Number of Fields, 3-13
Parsing Method: Delimiters, 3-13
Parsing Method: Width, 3-13
GPIB Instrument Setup dialog box, 3-1
to 3-2
Advanced Setup, 3-2
Board Index, 3-2
Delete, 3-2
Find and Add Instruments, 3-2
Index

New, 3-2
Primary Address, 3-2
Secondary Address, 3-2
Test, 3-2
Instrument Test dialog box, 3-3 to 3-4
  Read GPIB, 3-4
  Receive edit box, 3-3, 3-4
  Send Data, 3-4
  Transmit edit box, 3-3, 3-4
Tasks dialog box
  Close Instrument, 3-7
  Delete, 3-7
  Description, 3-7
  Edit, 3-7
  Edit Instruments, 3-7
  Edit Menu, 3-7
  Instrument list box, 3-7
  New Capture, 3-7
  New Transmit, 3-7
  Run, 3-7
  Tasks list box, 3-7
Transmission Task dialog box, 3-10 to 3-12
  Clear instrument, 3-11
  Command String, 3-11
  Delay, 3-12
  Description, 3-11
  Display status, 3-11
  End-of-line String, 3-11
  Repeat Count, 3-11
  Response String, 3-12
  Task Name, 3-11
  Timeout, 3-11
  Transmission Range, 3-11
  Trigger Instrument, 3-11
  Wait for SRQ, 3-11

I
Include option, Define Fields dialog box, 3-13
installation
  adding GPIB Add-In manually, 1-1 to 1-2
  Measure for Windows, 1-1
  removing GPIB Add-In manually, 1-1 to 1-2
  uninstalling Measure, 1-2
instrument configure task, creating, 2-8 to 2-9
Instrument list box, 3-7
Instrument Test dialog box
  Fluke 45 Multimeter example, 2-3 to 2-4
  GPIB task reference, 3-3 to 3-4
    Read GPIB, 3-4
    Receive edit box, 3-3, 3-4
    Send Data, 3-3, 3-4
    Transmit edit box, 3-3, 3-4
  illustration, 3-3
instruments
  configuring Fluke 45 multimeter (example), 2-2
  creating instrument configure task, 2-8 to 2-9
  creating instrument read task, 2-9 to 2-10
  definition, 2-1
testing the instrument connection, 2-3 to 2-4

L
LOCAL command (table), 2-13

M
Measure GPIB Add-In. See GPIB Add-In.

N
New Capture button, Tasks dialog box, 2-4, 3-7
New option, GPIB Instrument Setup dialog box, 3-2
New Transmit button, Tasks dialog box, 2-4, 3-7
nonprinting characters, entering, 2-12
Number of Fields option, 3-13
P

parsing fields
  by custom-defined delimiters, 2-6
  by width, 2-6 to 2-7
  using default delimiter, 2-7
Parsing Method: Delimiters option, 3-13
Parsing Method: Width option, 3-13
Primary Address option, 3-2

R

Read GPIB button, 3-3, 3-4
Receive edit box, 3-3, 3-4
reference, adding to GPIB Add-In, 4-1
to 4-2
removing GPIB Add-In manually, 1-1
to 1-2
Repeat Count option, 3-11
Response String option
  Capture Task dialog box, 3-9
  Transmission Task dialog box, 3-12
Result range option, 3-9
return values for Measure (table), A-1
Run button, 3-7
running tasks, 2-10 to 2-12

S

Secondary Address option, 3-2
Send Data button, 3-3, 3-4
SRQ command (table), 2-13
strings, specifying in communications, 2-12
to 2-13

T

Task Name option
  Capture Task dialog box, 3-8
  Transmission Task dialog box, 3-11
tasks
  adding to GPIB menu, 2-12
capture tasks
  parsing fields, 2-6 to 2-7
  purpose, 2-4
  steps in task, 2-5
creating
  instrument configure task, 2-8 to 2-9
  instrument read task, 2-9 to 2-10
definition, 2-4
Fluke 45 Multimeter example
  configuring, 2-2 to 2-3
  testing the instrument connection, 2-3
to 2-4
running, 2-10 to 2-12
transmission tasks
definition, 2-7
steps in task, 2-7 to 2-8
Tasks dialog box, 2-4
  GPIB task reference, 3-6 to 3-7
  Close Instrument, 3-7
  Delete, 3-7
  Description, 3-7
  Edit, 3-7
  Edit Instruments, 3-7
  Edit Menu, 3-7
  Instrument list box, 3-7
  New Capture, 3-7
  New Transmit, 3-7
  Run, 3-7
  Tasks list box, 3-7
illustration, 3-6
running tasks from, 2-10
Tasks list box, 3-7
technical support, B-1 to B-2
Test option, 3-2
testing instrument connection, 2-3 to 2-4
Timeout option
  Capture Task dialog box, 3-9
  Transmission Task dialog box, 3-11
Transmission Range option, 3-11
Transmission Task dialog box, 3-10 to 3-12
Clear instrument, 3-11
Command String, 3-11
Delay, 3-12
Description, 3-11
Index

Display status, 3-11
End-of-line String, 3-11
illustration, 3-10
Repeat Count, 3-11
Response String, 3-12
Task Name, 3-11
Timeout, 3-11
Transmission Range, 3-11
Trigger Instrument, 3-11
Wait for SRQ, 3-11

transmission tasks
  definition, 2-7
  steps in task, 2-7 to 2-8
Transmit edit box, 3-3, 3-4
TRIG command (table), 2-13
Trigger Instrument option
  Capture Task dialog box, 3-9
  Transmission Task dialog box, 3-11

U
uninstalling Measure, 1-2

V
Visual Basic for Applications (VBA)
calling functions from VBA, 4-1 to 4-2
GPIB Add-In functions
  CheckSRQ, 4-2 to 4-3
  CloseGPIBInstrument, 4-3
  GetMeasureGPIBError, 4-3
  GPIB, 4-4

W
Wait for SRQ option
  Capture Task dialog box, 3-9
  Transmission Task dialog box, 3-11
width, parsing fields by, 2-6 to 7